	Lesson Plan Title: Pop Triptych 
	Length: ~8 class periods

	Course Name 
	Painting
	Grade Level
	High School



	Enduring Understanding(s)	
	Prepared Graduate Competency(ies)

	Artists mirror society and culture when creating a work of art. 
	Comprehend
-Transfer the value of visual arts to lifelong learning and the human experience
-Recognize, articulate, and debate that the visual arts are a means for expression
-Analyze, interpret, and make meaning of art and design critically using oral and written discourse
Reflect
- Recognize, articulate, and implement critical thinking in the visual arts by synthesizing, evaluating, and analyzing visual information
Create
-Recognize, interpret, and validate that the creative process builds on the development of ideas through a process of inquiry, discovery, and research
-Develop and build appropriate mastery in art-making skills using traditional and new technologies and an understanding of the characteristics and expressive features of art and design
Transfer
-Transfer the value of visual arts to lifelong learning and the human experience

	Objectives/Learning Targets

	1. Students will be able to create a watercolor triptych inspired by the works of Andy Warhol.(Bloom’s: Creating; Standard: Create; GLE: Assess and produce art with various materials and methods)
2. Students will be able to express an emotion through photographs that show a reaction to scenarios related to current popular culture. (Bloom’s: Applying; Standard: Transfer; GLE: Communication through advanced visual methods is a necessary skill in everyday life)
3. Students will be able to demonstrate basic Photoshop editing techniques to create a black and white stencil of their portraits using the threshold effect. (Bloom’s: Creating; Standard: Create; GLE: Demonstrate competency in traditional and new art media, and apply appropriate and available technology to express ideas)
4. Students will be able to evaluate the relationship between Andy Warhol, popular culture, and Banksy’s ideas and techniques. (Bloom’s: Evaluating; Standard: Reflect; GLE: Reflective strategies are used to understand the creative process) & (Bloom’s: Understanding; Standard: Comprehend; GLE: Conceptual art theories explain how works of art are created)
5. Students will be able to write and verbally support their idea of Andy Warhol’s art by responding to the question, “is it art.” (Bloom’s: Evaluating; Standard: Reflect; GLE: Reflective strategies are used to understand the creative process; Interpretation is a means for understanding and evaluating works of art)
6. Students will be able to use their knowledge of an art critic to write either a good or bad review about a piece of Andy Warhol’s art based on random selection. (Bloom’s: Creating; Standard: Create; GLE: Recognize, compare, and affirm that the making and study of art and design can be approached from a variety of viewpoints, intelligences, and perspectives) (Bloom’s: Evaluating; Standard: Transfer; GLE: The work of art scholars impacts how art is viewed today; Art is a lifelong endeavor)
7. Students will be able to analyze Andy Warhol’s art while on a field trip to a museum and after the experience respond again to “is it art.” (Bloom’s: Analyzing: Standard: Reflect; GLE” Interpretation is a means for understanding and evaluating works of art)



	Accommodations and Modifications 

	Write, speak and demonstrate instructions and techniques. Repeat what the students will be doing for that day, and the expected outcome of the exercise 
Have instruction/guideline worksheet both printed and electronic  
Students can use a template to lay out their triptych 
Students can take their own picture 
To challenge students have them create their own popular culture scenario for them to react too 



	Vocabulary/Literacy Integration

	Watercolor, Masking fluid, Threshold, Burn/Dodge, Scenario, Stencil, Pop art, Street art, Layer, Composition, Triptych, Portrait, Critic, Expressive features  
Students will…
· Discuss as a table group as well as a class
· Rake notes on Andy Warhol
· Write which scenario they reacted too in their sketchbook as well as on the back of their final painting 
· As a group write a critical judgment review on a piece of art
· In sketchbook answer, “Is it art.”
· On field trip answer questions about one of Andy Warhol’s prints 



	Materials
	

	Computer lab
Photoshop
Camera
32 sheets of watercolor paper
Watercolor paint (tube)
Masking fluid
Paint brushes 
Documentation camera
Banksy videos
Field trip notes ppt
Field trip permission slip/itinerary 
	Tape
Pencils / erasers
Light box
Window
Printer
6 layout stencil 
Assignment handout
Word photo template
Warhol PowerPoint 
Critique worksheet
6 different Andy Warhol prints 





	Resources

	http://www.colbertnation.com/the-colbert-report-videos/429573/october-07-2013/banksy-s-new-york-reign-of-terror
http://youtu.be/UgdHeac4bsM
http://youtu.be/jUh_NSpiTsY
http://youtu.be/SdbOrNLcC0I
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Photoshop threshold word doc/ppt
1. File >> Open >>(Your photo)
2. Image>> Mode >> Grayscale
3. Filter >> Blur >> Gaussian Blur (2-3 Pixels) 
4. Layer → Duplicate background layer
5. Image → Adjustments → Threshold → Move toggle right or left till you find the perfect outline
6. If there are spots you would like to lighten up or darken…
    1. Select background image
    2. Dodge (lightens) or burn (darkens) tool. 
7. File >> Save As… >> Save to your student folder as a JPEG

Field trip questions
1. Title: (title,date,size)
2. Why do you like it?
3. What do you see? (Color, shapes, textures, objects)
4. DRAW IT! Approximately ½ page 
5. Meaning- Interpret what the artist is trying to say 
6. One piece you don’t like and why

Artwork for critic review
100 Cans (1962)
Untitled from Marilyn Monroe (Marilyn) (1967)
Brillo Boxes (1969 version of 1964 original) 
Mao (1973)
General Electric with Waiter (1984)
Self-Portrait (1986)



	Preparation

	Pictures will be taken during watercolor intro 
There will be a list of 5 different scenarios. We will read each scenario, and your picture should show your expression related to the scenario.  
· Students have the option to take their own picture using their phones, but will be due on Feb. 5th.
· Student pictures will be uploaded to their student file or have in their email.
The scenarios
1.You are watching the Superbowl halftime show, and Bruno Mars doesn’t show up! Then the broncos lose
2.Miley Cyrus fell off of a wrecking ball
3.You are walking down the street and see a large group of people planking… Then they start doing the Harlem shake 
4.Yolo 
5.Justin Bieber gets deported 
Other preparation
· Paper work for field trip
· All PowerPoints / Youtube videos/ worksheets/ handouts
· Stencil layout
· Teacher example of triptych / Photoshop step by step
· Watercolor supplies set out (wax resist containers / watercolor tubes / watercolor technique boxes / watercolor paper cut)


 
	Motivation / Anticipatory Set

	http://www.colbertnation.com/the-colbert-report-videos/429573/october-07-2013/banksy-s-new-york-reign-of-terror
Group discussion answering:
Do you think graffiti or street art is art?
What is the purpose of it?
Do you think using a stencil is ‘cheating’?


Procedures
	Day 1
	
	Time

	1.
	All you need is a sketchbook and something to write with
Start video clip #1 
http://www.colbertnation.com/the-colbert-report-videos/429573/october-07-2013/banksy-s-new-york-reign-of-terror 
	10 min 

	2.
	When video is over, ask:
- Do you think graffiti is art?
- What is the purpose of it?
- Do you think using a stencil is ‘cheating’?
	5 min

	3
	Start video clip #1 http://youtu.be/UgdHeac4bsM
	10 min

	4.
	When video is over, ask:
-What technique is Banksy using?
- How has he never been caught? 
	5 min 

	5.
	Work on Calendar for rest of class
-Due Wednesday 
	20 min



	Day 2
	
	Time

	
	Students attach the calendars with paper fasteners 
 -Make sure the months are in order
- Put your name on the back 
- Turn in to portfolio 
- You have 10 minutes 
- When done take out your sketchbook and something to write with 
→ Remind students to have their pictures done by the next class period. Ask which students still need to have their picture taken. (Friday)
When done take out your sketchbook and something to write with 
→ Remind students to have their pictures done by the next class period. Ask which students still need to have their picture taken. (Friday)
	10 min

	1
	Today we will be introducing our next project. So all you’ll need today are your sketchbooks and something to write with
Recap what we did last class
- Banksy videos 
Ask:
Why do you think we watched this?
What is one thing you found most interesting?
Can you think of a famous artist who might have inspired Banksy’s style? or graffiti in general? 
	10 min

	2
	PowerPoint on Andy Warhol
	20 min

	
3
	Intro to Project

1. Take 5 pictures of your reaction to a popular culture scenario
Take your photos:
- In front of a light blank wall / Well-lit area in direct light / Up close from your shoulders up
(The blank wall by the greenhouse in the hall by the drawing room works great!)
2. Upload photos to student folder By Friday Feb. 7th (if you take your own)
3. Chose 3 of the 5 photos  
- Remember what pop culture scenario you are reacting too 
4. Create a stencil of your portrait using Photoshop
5. Print out the three Photoshop stencils  
- In the class folder there is a word template that the photos need to fit in.
- Each photo will be roughly 8.5 in x 5 in
6. On watercolor paper trace the triptych layout using the premade template
7. Use a window or a light box to trace around the negative space of your portrait stencil
8. Use masking fluid to fill in negative space of your drawing
- It will look funny, but when you take off the masking fluid it will look like your stencil
9. Use at least one of the watercolor techniques/textures you explored in your calendar
- Wet-on-wet / Wet-on-dry / Dry brush / Gradation / Salt / Sponge
(Other options to create texture - Splatter / Saran wrap / Lifting color / etc…)
10.  Write on the back of your painting which pop culture scenarios you reacted to
Things to think about:
- The order and placement of your portraits within the triptych
- Visual Balance, Visual Movement, Color, Texture, Space, and Unity.
- How with the use of color and texture you can enhance the expression shown in your portrait.
	20 min

	4
	By a show of hands who has used Photoshop before? 
	1 min

	5
	Tell the class that tomorrow we will meet in the computer lab to start our project… and if they chose to take their own pictures to make sure they are uploaded to their student folder or emailed to themselves so we can start working on them the next class period. 
	1 min

	6
	If there is time left let the students go take their pictures or finish their calendars 
	



	Day 3
	
	Time

	1
	Computer lab 
- Demo threshold technique on Photoshop 

Put step by step directions in the class folder 
1. File >> Open >>(Your photo)
2. Image>> Mode >> Grayscale
3. Filter >> Blur >> Gaussian Blur (2-3 Pixels) 
4. Layer → Duplicate background layer
5. Image → Adjustments → Threshold → Move toggle right or left till you find the perfect outline
6. If there are spots you would like to lighten up or darken…
    1. Select background image
    2. Dodge (lightens) or burn (darkens) tool. 
(Keep the threshold layer visible so you can see what changes.)
7. File >> Save As… >> Save to your student folder as a JPEG
	20 min

	2
	Rest of day to work on photos. 
· Print out stencils 
· Landscape-2 per page (8.5x5)
	70 min

	3
	Meet back in the classroom next class

	

	Day 4
	
	Time

	1
	Demo:
· Triptych layout using stencil
· Light box or window to trace stencil onto watercolor paper
· Draw light! 
· How to apply tape to boarders and paint board
	15 min

	2
	Students work 
- Computer lab if needed
	30 min

	Day 5
	
	Time

	1
	Demo:
· How to apply wax resist around drawing
· Have warm water and soap at desk to clean brush while working otherwise the wax resist will ruin your brush
	15 min

	2
	Students work 
- Computer Lab if needed 
	70 min

	Day 6/7
	
	Time

	
	Student work days 
	45 min

	
	Hand out field trip permission slip and itinerary - needs to be signed by parents the day before the field trip
	



	Day 8
	
	Time

	1
	Remind students that today is the day of the field trip and we are going to do some activities to prepare us. All they need out is a sketchbook and something to write with
· Turn on http://youtu.be/SdbOrNLcC0I
· After video have students answer “is it art” in their sketchbooks
	15 min

	2
	· Does what a critic says influence the viewers opinion on something?
· Have you ever read a movie review? 
· Read a review on something you were going to buy?- Did it change your mind?
Turn on http://youtu.be/jUh_NSpiTsY
· After video discuss the role of a critic 
· During discussion pass out Andy Warhol prints to each table 
	15 min

	3
	At each table students will be given a copy of one of Andy Warhol’s paintings. On the backside it will either say good or bad. As a group students will write a review defending the view based on the painting at their desk. 
	15 min

	4
	Each group reads their review to the class
- Class decides if it was suppose to be a good review or a bad review
	15 min

	5
	Pull up what they will be doing at the field trip ppt
· Students write in sketchbook the questions they will have to answer at the museum 
1. Title: (title,date,size)
2. Why do you like it?
3. What do you see? (Color, shapes, textures, objects)
4. DRAW IT! Approximately ½ page 
5. Meaning- Interpret what the artist is trying to say 
6. One piece you don’t like and why
· The drawing must be half a page
· Be descriptive – Use appropriate art terminology 
· Write a response again to “is it art” after the field trip- Did seeing the work in person change your perspective? 
	10 min 

	6
	Spend the rest of the class finishing up watercolor triptych
- Due the following class period 
	20 min

	7
	Everyone meet in drawing room at 9:15
	

	8
	With whole group:
· Hand out itinerary 
· Give directions to museum 
· Make sure everyone knows who they are driving with
· Museum expectations 
· How to get to CSU museum 
· Explain what happens if they are late 
	10 min



	Post-Assessment
	Post-Assessment Instrument

	· Did the student create a watercolor triptych inspired by the works of Andy Warhol?
· Did the student take 5 portrait pictures that is a reaction to scenarios related to current popular culture?
· Did the student demonstrate basic Photoshop editing techniques to create 3 black and white stencils of their portraits using the threshold effect?
· Did the student write a response in their sketchbooks that supports their idea of Andy Warhol’s art by answering to the question, “is it art?” 
· Did the student write either a good or bad review about a piece of Andy Warhol’s art based on random selection?
· Did the student analyze Andy Warhol’s art while on a field trip and answer the questions in there sketchbook as well respond again to “is it art?” 
	Sketchbook check-
Andy Warhol notes___/10pts
Is it Art response 1 ___/20pts
Field trip notes ___/30pts (5pts each question)
Is it Art response 2 ___/20pts

Did they…
Write a critic review in a group ___/20pts
Take 5 reaction pictures? ___/25pts

Final Rubric 
Project Requirements: 5pts each = 25pts total
	
	5 portrait reactions

	
	Chose 3 different reactions for final piece

	
	Wrote which scenarios reacted to on the back

	
	Created 3 panels that are 8.5x5

	
	Each panel is a different


Use of medium/craftsmanship: 5pts each = 25pts total
	
	Used at least one watercolor technique that was used on watercolor calendar 

	
	Demonstrated clear understanding of color theory when mixing colors

	
	Masking fluid applied and removed cleanly to create sharp edges and no paint on white areas

	
	No pencil marks easily seen

	
	Added finishing touches after removal of masking fluid (white acrylic paint to cover any paint in white areas/to hide pencil marks/clean up edges)


Composition: 5pts each = 25pts total
	
	Each panel is strong on its own

	
	Three panels create a cohesive composition 

	
	Considered elements and principles when creating composition including color

	
	Color choice enhances the reaction being shown 

	
	Scale of portrait fills the space 


Participation: 5pts each = 25pts total
	
	Comes to class fully prepared 

	
	Works from bell to bell 

	
	No tardies or unexcused absences. 
(each tardy/unexcused absence -1)

	
	Full effort and participation shown daily 

	
	No cell phone use in class 


           / 100
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1. Take 5 pictures of your reaction to a popular culture scenario
Take your photos:
- Infront of a light blank wall
- Well-lit area in direct light
- Up close from your shoulders up
(The blank wall by the greenhouse in the hall by the drawing room works great!)

2. Upload photos to student folder By Friday Feb. 7™
(if you take your own)

3. Chose 3 of the 5 photos
- Remember what pop culture scenario you
are reacting too

4. Create a stencil of your portrait using Photoshop

5. Print out the three Photoshop stencils
- Inthe class folder there is a word template
that the photos need to fit in.
- Each photo will be roughly 8.5inx 5 in

)\
6. On watercolor paper trace the triptych layout using the premade template

7. Use a window or a light box to trace around the negative space of your portrait stencil
- Draw lightly

8. Use masking fluid to fill in negative space of your drawing
- It will look funny, but when you take off the masking fluid it will look like your stencil

9. Use at least ONE of the watercolor techniques/textures you explored in your calendar
- Wet-on-wet / Wet-on-dry / Dry brush / Gradation / Salt / Sponge
(Other options to create texture - Splatter / Saran wrap / Lifting color / etc...)

10. Write on the back of your painting which pop culture scenarios you reacted to

Things to think about:
- The order and placement of your portraits within the triptych
- Visual Balance, Visual Movement, Color, Texture, Space, and Unity.
- How with the use of color and texture you can enhance the expression shown in
your portrait.

Field Trip Wednesday, Feb. 19
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FCHS ART FIELD TRIP
WEDNESDAY, February 19, 2014

The Fort Collins Museum of Art is currently exhibiting “Andy Warhol Prints from the Cochran
Collection.” This exhibition features works from throughout the career of one of the most
important and influential artists of the 20t century, Andy Warhol. We have also been invited to
the University Art Museum at the old Fort Collins High School to go behind the scenes and view
CSU's private Warhol collection. Students on this field trip will be given the opportunity to view
famous artwork in a gallery setting as well as getting to see how and where a museum stores
their private collections.

COST: $10.00 FOR LUNCH (OPTIONAL) OR PACK YOUR OWN LUNCH

SCHEDULE

9:15 am- Meet in R105

9:30 am - Leave FCHS in route to Fort Collins Museum of Art.

10:00-11:00 am - View “Andy Warhol Prints from the Cochran Collection”

11:00-11:50 am - LUNCH

*Students may pack a lunch to eat in the lobby of the University Center for the Arts @ CSU or eat at a near by restaurant
11:50 — Meet at the entrance to the University Art Museum

12:00-12:30 - Private viewing of CSU’s Andy Warhol collection (GROUP 1)
-- View “Innovators and Legends: Generations in Textiles and Fiber” at the UCA (GROUP 2)

12:30-1:00 - Private viewing of CSU’s Andy Warhol collection (GROUP 2)
-- View “Innovators and Legends: Generations in Textiles and Fiber” at the UCA (GROUP 1)

1:05 - Meet at the entrance to the University Art Museum
1:15 - Leave UCA in route to FCHS
1:45 - Arrive at FCHS

1 (student signature), Understand that all FCHS rules and regulations
apply during the course of this field trip. I also agree that, as a representative of Fort Collins
High School, I will present myself in a respectful and appropriate manner throughout the
course of this fieldtrip.

Signature of Parent/Legal Guardian, Date:
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